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1 Introduction to Shuttle Devices

Contour Shuttle devices have been designed to enhance the productivity of multimedia content
creators, but they also increase productivity in many other types of applications, including:
. graphics and photo editing

. word processing

. spreadsheet manipulation

. internet operations

. medical imaging

. any application that uses key commands

Contour Shuttle devices consist of two (2) components: the ergonomically designed device itself
and the software that allows you to manage it.

All Contour Shuttle devices have a Jog wheel and a Shuttle ring that are programmabile.

The ShuttleXpress has five (5) programmable buttons, the ShuttlePRO has thirteen (13)
programmable buttons, and the ShuttlePRO v2 has fifteen (15). The two top rows of buttons on
the ShuttlePRO series have removable caps so the included labels can be inserted for quick
reference as to which functions each button is programmed to perform.

Buttons, Jog wheel and Shuttle ring will be referred to as Shuttle components.

% Top row of four {4) buttons,

numbered 1 through 4, left to right
% Second row of five (5) buttons,

numbered S through 9, left to right

Left side button, numbered 14 Right side button, numbered 15

Joq Wheel

Third row of two (2) buttons
{below the Jog and Shuttle Knob),
numbered 10 and 11, left to right

Shuttle Ring or Shuttle Knob
{outer, black, spring-loaded ring)

Fourth row of two (2) buttons
{just above the palm rest),
numbered 12 and 13, left to right
Palm Rest
% The Top row of four (4) buttons
and the second row of five (5)
buttons contain clear removable
key caps for custom labeling.

Fig. 1-1 ShuttlePRO v2 Layout
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Fig. 1-2 ShuttlePRO Layout

Top row of five (5) buttons,
numbered 1 through S, left to right

Shuttle Ring or Shuttle Knob
{outer, black, spring-loaded ring)

Jog Wheel

Palm Rest

Fig. 1-3 ShuttleXpress Layout

The Shuttle device software allows you to manage a specific configuration of your Shuttle device
for every application you have on your computer.

The software will automatically select the appropriate configuration according to the current
active application.

The installation package provides pre-installed settings (factory settings) for many common
applications; you can modify these settings at anytime and/or create new settings for other
applications, through the Shuttle device Control Panel.

1.1 Installing Shuttle Device Software

It is recommended to install the software before plugging your Shuttle device into any
available USB port.
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1.1.1 System Requirements

. System running Windows 7 and later

. Available USB port. (A direct USB port connection is desirable, but a hub connection will
also work. Contour recommends using powered hubs and against using conversion
devices, such as USB adapters.)

. 10 Mbyte of hard disk space for the Shuttle device driver installation.

1.1.2 Installation Procedure

Notes:

1) If you have any previous Shuttle devices driver installed on your system, please refer to
paragraph 7 (Updating or Uninstalling your Shuttle device Software) before proceeding.
3) For Windows 7 and later users: installing the driver requires system-administrator security

privileges.

Step 1. Locate and double-click the Contour Shuttle device driver installer.

Step 2. A dialog box will prompt you through the installation process. Once installation is
complete you should receive a message stating, “"Contour Shuttle Device Driver has
been successfully installed. Press the Finish button to exit Setup program.”

® Contour Shuttle setup @

Installation Complete

http:/ /www.contourdesign.com

Contour Shuttle has been successfully installed.
Press the Finish button to exit Setup program.

A-CNWhi Y
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2 Shuttle Device Control Panel

The Shuttle Device Control Panel is the component of the software that allows you to manage

your Shuttle device by defining and/or modifying application settings.

Application settings are the individual sets of actions associated to the Shuttle components for a
pre-determined application. Stated differently, the Control Panel manages application settings.

Changes performed on the application settings are enabled as soon as you click on the Apply or
OK button in the Control Panel.

The Control Panel does not need to be open when you use the Shuttle device.

The software automatically detects the program you are using and automatically switches to
the correct application settings associated with the application.

2.1 Control Panel Overview

Contour Shuttle Device Configuration

‘ ShuttlePRO v2 | ShuttlePRO || ShuttleXpress | Key Composer™ | About

Target Application

Menu

Fig. 2-1

Contour Shuttle Device Configuration

ShuttlePRO v2 | Key Composer™ | About

Settings management
Target application

O GlebatSetting v‘

A ;( )
Do ®

Device events control
User action

[O Shuttle in Right 4
Computer response

’ Type Keystroke

Keystroke
’ Mot assigned

Once Only

Comment

|

| ok J[ Cancel ][

Apply

]
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User Action Menu

Computer Response
Menu

Keystroke Field

Frequency Menu

Comment Field



2.2 Opening the Shuttle Device Control Panel

The described method provides the fastest access to the Shuttle device Control Panel and to
some of its frequently used features.

Step 1. Locate and click the Shuttle device Helper Menu icon.
The Shuttle device Helper is located in the Task bar, which is located in the lower
right hand corner of your screen. It is represented as a gray jog and shuttle ring
icon.

[ —

&)@ v, 5:30PM
Fig. 2-2

Step 2. A pop up menu will appear.

ShuttlePRO ¥2 Primary
v Global Settings
& Open Control Panel
Fig. 2-3
Step 3. Click Open Control Panel from the menu.

Note: The Contour Shuttle Device Configuration panel is an applet of the Windows Control
Panel. Therefore, the Contour Shuttle Device icon also appears in the Windows Control
Panel.

The Shuttle configuration icon may also appear in the Programs submenu, depending on the
installation options you chose.

2.3 Control Panel Components

The Control Panel consists of two sections:

. the settings management section — this section acts on settings as a whole. It allows
you to select existing settings, to create new settings and to import/export settings.
. the device events control section — this section acts on each of the Shuttle device

components for the setting selected in the Target Application Menu.
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2.3.1

2.3.1.1

Target application

9 Global Settings v

95 Adobe Acrobat Reader A
®, Adobe After Effects

% Adobe Illustrator 10

® Adobe Photoshop 7

®5 adobe Premiere (Clip Edit)

®p Adobe Premiere (Digitize)

® Avidxpress DY (Clip Edit)

®p Avidypress DV (Digitize)

®5 Boris RED 2.0

®p Cakewalk Guitar Tracks Pro

®p Cakewalk Home Studio 2000_XL
®p Cakewalk Music Creator

95 Cakewalk Plasma

®p Cakewalk Sonar 2

®a Canopus DY Rex Pro

®p Canopus DY Rex Pro 2
@ Canons DY Bey BT

2.3.1.2 Options Button

Create new settings
Rename settings

Change target application
Change target device
Revert to factory settings
Remove settings

Import settings
Export settings
Export settings info

Rebuild the whole settings file

Target Application Menu

Settings Management Section

This menu stores all of the currently installed application
settings. In order to view or customize an application
setting you will have to first select it through this menu.

This menu contains a Global Settings selection, which is
a setting that is active when the current application
doesnt have any specific settings assigned (the
application is not targeted).

Let’s explain this through an example: in the installation
package, Notepad doesnt appear in the Target
Application Menu, meaning there are no specific settings
for Notepad. Therefore, whenever you use the Notepad
program, your Shuttle device is configured according to
the Global Settings. Please refer to paragraph 3.5 for
more information about Global Settings.

Adobe Premiere, on the other hand, would use the
Adobe Premiere specific settings and NOT Global
Settings.

This button allows you to select functions to work on
settings. These functions include:

. Create new settings does what the name
implies — selection of this option allow you to
create new settings, either from empty
settings, or copying from Global settings or
the current application selected in the Target
Application Menu.

. Rename settings allows you to change the
selected setting name. This command is not

allowed on Global Settings.

. Change target application This option allows you locate a different executable file for
the application corresponding to the selected setting. This option is useful when a new
version of a program changes the name of the executable file itself.

. Change target device If you have two Shuttle devices, this option allows you to
specify which device, primary or secondary, the selected setting will respond to. Global
Settings are always active for all devices.

. Revert to factory settings allows you to restore a setting that you may have
modified, by reloading the original setting.
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. Remove settings allows you to remove the selected setting from the Target
Application Menu. This command is not allowed on Global Settings.

. Import settings allows you to add a new setting created by Contour, or another
Shuttle user, to the existing settings list.
. Export settings allows you to export the setting selected in the Target Application

Menu, in order to share it with other users, or back it up for security. The file that will be
created will have the .pref extension and will be located in the folder of your choice.

. Export settings info will create an html file that will contain an image of the Shuttle
device with bubble descriptions (the contents of the Comment field) of the actions
associated to each of the Shuttle components.

. Rebuild the whole settings file resets the settings collection of all Shuttle devices to
the factory provided one. With this operation all user-made and customized settings will
be lost.

2.3.2 Device Events Control Section

2.3.2.1 User Action Menu
This menu allows you to choose which button(s) or

User action .
= : feature(s) you wish to program. You can select any of
aisal LN R the buttons, Jog right or left, Shuttle positions and
sy Button 9 » transitions.
Z Button 10
¥ Button 11 Shuttle positions are points set in intervals along the
Z Button 12 right and left (clockwise and counterclockwise) sides of
%3 Button 13 the Shuttle Knob. The Shuttle ring has seven (7) distinct
@) Jog Left zones in each direction and a rest zone.
(%) Jog Right Shuttle transitions are points in between Shuttle
() shuttle in Left 7 positions.
&) shuttle in Left 6
&) shuttle in Left 5 Note: The primary buttons, Jog directions and Shuttle
positions can be accessed more easily by simply clicking
&) shuttle in Left 3 the desired button or moving the Jog or Shuttle on the
() shuttle in Left 2 v device itself. This will automatically bring its option up in

the User Action Menu. Shuttle transitions are only
accessible through the pull-down menu.

2.3.2.2 Computer Response Menu

Computer response The Computer Response Menu allows you to pick a function
Do Nothing v that you want a button or other feature to perform:
T Do Nothing does what the name implies -
: - selection of this option means that the button or other
Same as Lower Yalue . .
s feature will do nothing.
eSS . Same as Lower Value will perform the same
Type Ke*'ftmke function as the immediately previous command on
Mouse Chick the shuttle knob. This command is only allowed on
Mouse Wheel the Shuttle positions.
Switch settings
Macro
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. Press Modifiers This option allows you to place one or more Modifier keys in a given
target button. The Modifier keys are the Shift, Alt, Control and Win keys.

. Type Keystroke on the menu allows you to type a keyboard shortcut in the Keystroke
field. The text associated with Keystroke field (Comment field) provides additional
guidance.

. Mouse Click will allow you to associate a mouse click. A Modifier key can be also
associated to the mouse click.

. Mouse Wheel will either perform a wheel up or wheel down movement. A Modifier key
can be also associated to the wheel movement.

. Switch settings allows you to perform as a toggle in cases where an application has
more than one application setting defined.

. Macro (ShuttlePRO v2 only) allows you to associate one of the available macros to a

Shuttle component or to create your own macro.

2.3.2.2.1 Modifier Keys and Smart Release Check Box

A Modifier key is one of the following keys: Shift, Alt, Control, Win. Modifier keys can be
selected one at a time or combined together.

Modifiers
| shirt | [ at | [control| [ win |
Smart release

Fig. 2-4

You can program the Shuttle components to perform repeated pressure (or hold down) of the
modifier keys. The Smart Release checkbox enables a software optimization of these repeated
keystrokes in order to optimize application performance.

However, this optimization may interfere with some applications, usually games, that have a
particular specialized use of the modifier keys. In those cases you can disable the Smart
Release feature.

2.3.2.2.2 Press Modifiers

Computer response The Press Modifiers action is used when you want a
Press Modifiers +~ | button, jog or shuttle position to perform a modifier key.
Modifiers

| shirt | | &k | [control| [ win |

Smart release

Contour Shuttle Multimedia Controllers 8



2.3.2.2.3 Frequency Menu
Frequency The Frequency Menu allows you to specify how many times
' | you want a command to occur. It allows the event to occur
once, as fast as possible, or a specified number of times
Hold Down ~

¥ 5 per second, or at slower speeds measured by the number
Fiok Eown Snel Suka Repest of seconds between occurrences.
As Fast As Possible

60 Times per Second Let's point out the difference between Once Only, Hold

Once Only v

45 Times per Second Down and Hold Down and Auto-Repeat:
30 Times per Second . Once Only simulates a keystroke pressure
15 Times per Second v immediately followed by its release.
. Hold Down simulates a keystroke pressure until the associated Shuttle component is
released.
. Hold Down and Auto-Repeat simulates many time-spaced keystroke pressures until the

associated Shuttle component is released.

The Frequency Menu is available for the following Computer Response actions:

. Type Keystroke
. Mouse Click
. Mouse Wheel

2.3.2.2.4 Type Keystroke
Choosing this action allows you to type into the Keystroke Field the keyboard shortcuts that you
want a button or Jog Wheel or Shuttle Knob position to perform.

Computer response

Type Keystroke v
Keystroke
Shift + Control + Right Arrow e Keystroke Field
Smart release
Frequency
Once Only v

Instead of typing special keystrokes on the keyboard, you can select them from the List Button,
by clicking on the corresponding right side icon:
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Function Keys >
Caps Lock

Mumeric pad Keys 4 Up Arrow
Special Keys 4 Down Arrow

Left Arrow

Right Arrow

Page Up

Page Down

Home

End

Insert

Delete

Backspace

2.3.2.2.5 Mouse Click

This action allows you to associate a mouse click (either left,
1 middle or right) to a Shuttle component. A Modifier key

Computer response

‘.,Mwse ek ¥ can also be associated to the mouse click in order to modify
its behavior.

Mouse click The click frequency can be set through the Frequency

| teft | [ mdde | [ right | Menu.

Modifiers

[ shiit | | ak | [contral] | win |

Smatt release

Frequency

iOnce Only vi

2.3.2.2.6 Mouse Wheel

Computer response This action allows you to associate the scrolling feature
‘"‘Mouse Wheel | (wheel up or wheel down) to a Shuttle component. A
L —— Modifier key can also be associated to the wheel movement.

The wheel tick frequency can be set through the
Mouse wheel Frequency Menu.

| up | | pown |

Maodifiers
[ shitt | | ak | [contral| [ win |
Smart release

Frequency

[ |
lOnce Only v ‘
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2.3.2.2.7 Switch settings

Computer response

Switch settings

Switch settings to

[Previous ] [ Next

This action allows you to perform as a toggle in cases where
an application has more than one application setting
defined for it.

This action is an alternate method of switching settings,
which can be faster than using the Shuttle device Helper
in the task bar (please refer to paragraph 4.1 for more
information about this method).

In order for this option to work efficiently, all settings for a
program SHOULD have this option enabled, preferably all
on the same button.

Let’'s explain this through an example: suppose you have

three (3) different settings for a specific program and that Button 1 is defined as “Switch to the
Next Setting” for all the three settings. When the program is first loaded, the first setting is the
default. When you press Button 1, you will switch to the second setting. And when you press it
again, you will switch to the third setting. Press Button 1 again to go back to the first setting.
2.3.2.2.8 Macro (ShuttlePRO v2 only)

Computer response

Macro

Macro

2.3.2.3 Comment Field

Comment

Forward frame by frame

This action allows you to associate to a Shuttle component
one of the existing macros by choosing it from the pull-
down menu, or to create your own new macro. To learn
more about how create new macros, refer to paragraph 6
(Programming macros with Key Composer™ (ShuttlePRO
v2)).

The Comment Field allows you to write a comment
about a command. Click the field and type in a
description.
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3 Using your Shuttle device

Now that you have become familiar with the Control Panel components, let’s move on to using
and modifying existing settings.

Before going through the contents of this section, open the Control Panel (refer to
paragraph 2.2 for guidance on how to accomplish this).

Note: Changes you perform on settings will not take effect until you press Apply or
OK. (OK will automatically close the Control Panel.) You can press Cancel to close the
Control Panel without saving your changes.

3.1 Going through Existing Settings

In order to view the Shuttle components definition for a particular application, perform the

steps below:

1. Choose an application from the Target Application Menu.

2. Press each of the buttons of your Shuttle device controller (or select them in the User Action
Menu) to see the computer response associated to the button and the related explanation in
the comment field.

3. Move the Jog and the Shuttle on your Shuttle device controller (or select the Jog/Shuttle
positions and the Shuttle transitions in the User Action Menu) to see the computer response
associated to each position of the Jog and Shuttle components.

For a more general overview of settings functions, proceed to the paragraph below.

3.2 Exporting Settings Info

To create an html file that contains all the settings information:

1. Click on the Target Application Menu and select the application setting you would like to

export. (After so doing, you should see the setting name highlighted in the Target

Application Menu).

Click on the Options button. Select Export settings info from the pull-down menu.

A dialog box will prompt you to type a name for the file that will be created and to choose

its destination folder. Once you have done so, click on Save in the lower right hand of the

dialog box.

4. Locate and double-click to open the newly created file. We suggest you print it for your
reference when using the application.

w N

Note: The html file is printable using any Internet browser. We suggest you set the page
orientation to landscape in your printer options.

Below is the html file created with the Export Settings Info option for Adobe Premiere (Clip
Edit).
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Cefault Transition
Lift

Reverse Play

Go to Previous Edit

Setin point/marker

Left side Shuttle Positiors

1 Reverse S frames per sec.
2 Reverse 10 frames per sec.
3 Reverse 15 frames per sec.
4 Reverse 30 frames per sec.
S Reverse 45 frames per sec.
6 Rewmind

7 Remind

Clear in point/marker

Toggle source and program

Overlay source clip ateditlin

Insert source dip at editline

Forward Play

Go to next edit

Set out paint/marker

Right side Shuttle Positions
Forward S frames per sec. 1
Forward 10 frames per sec. 2
Forward 15 frames per sec. 3
Forward 20 frames per sec. 4
Forward 45 frames per sec. S
Fast Forward 6

Fast Forward 7

Clear out point/marker

Toggle monitor and timeline

Fig. 3-1 Exported settings info for Adobe Premiere (Clip Edit)
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3.3 Associating a Function with a Shuttle Component

When you modify an existing or newly created setting, you want to modify the function
associated with the Shuttle components.
These steps are general and we will refer to this paragraph often hereafter.

First open the Control Panel and select one application setting in the Target Application Menu.

1. Through the User Action Menu, select the Shuttle component you want to assign the
function to. You can choose between:
f button
f jog
f Shuttle position
f Shuttle transition.

2. Click on the Computer Response Menu and select the function you wish the Shuttle
component to perform. Choose according to the following table:

Button | Jog Direction | Shuttle Position | Shuttle Transition
Do Nothing X X X X
Same as Lower Value NA NA X NA
Press Modifiers X X X X
Type Keystroke X X X X
Mouse Click X X X X
Mouse Wheel X X X X
Switch settings X X X X
Macro (ShuttlePRO v2 only) X X X X

3. Add a description of the requested action in the Comment Field
4. Click Apply when completed.

3.4 Modifying Existing Settings

This section explains how to modify a function of the Shuttle device for an existing application
setting.

1. Click on the Target Application Menu and select the application setting you would like to
modify.

2. Click on the User Action Menu and select the Shuttle component whose function you wish

to change. Once chosen, you should see it highlighted in the User Action Menu. In order to

modify its function, refer to paragraph 3.3 for guidance on how to accomplish this.

Repeat step 2 for each Shuttle component you would like to modify.

Once you have completed the desired changes, click Apply. The new settings will

immediately take effect. (There is no need to restart the computer.) Next time you reload

the setting, you will notice that the label below the Target Application Menu will appear as

“Customized Settings”, instead of “Factory settings” to indicate you made changes to the

application setting.

5. You can now close the Shuttle device Control Panel and use your Shuttle device.

W

Note: you can always use the Options menu item Revert to Factory Setting, or remove the
setting and re-import it to reverse your changes later.
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3.5 Programming Global Settings

Global Settings is a setting that works in all the applications that do not have specific settings
listed in the Target Application Menu. Stated differently, if you have settings defined for a
particular application, Global settings will not be activated for that application, since it is meant
for general purposes only.

Global Settings can't be targeted to the primary or secondary device: it's always targeted to
both devices.

When you open the Control Panel, Global Settings is always selected in the Target Application
Menu. By default, all the Shuttle components in Global Settings are set to Do Nothing.

However, Global Settings can be used to close applications and/or for scrolling purposes. For
example, associate:

. Alt+F4 (close the current window) to a button,
. the mouse wheel movement to the jog directions and
. the left and right arrows to the Shuttle ring positions by varying the frequency.

Global Settings can be modified the same way you would when you modify any other setting,
by following the steps of paragraphs 3.4 and 3.3.

In Appendix 1, you will find a step-by-step example on how to program Global Settings on the
ShuttlePRO, performing the above associations.
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4 Multiple application settings and multiple devices

Some applications, such as Adobe Premiere or Pinnacle Edition, allow multiple modes of usage
Contour Shuttle devices address some of them by providing multiple sets of application settings
for these applications in the installation package.

If you have one Shuttle device, you can switch between these settings through the Shuttle device
Helper.

If you have two Shuttle devices, one of them will be targeted as primary device and the other
one as secondary device; and, for multiple mode applications, you can associate a setting to the
primary device and another setting to the secondary device.

4.1 Using the Shuttle Device Helper to Switch Settings

If you are using an application with multiple application settings, you can switch between them

quickly via the Shuttle device Helper.

To switch settings or modes, do the following;

1. With desired application open and in the foreground, click the Shuttle device Helper (found
in the Task Bar. Refer to Fig. 2-2 on page 5.)

2. Notice that the Shuttle device Helper has each setting currently installed for the desired
application listed. The current active setting is shown by a small check mark. Click the
setting you want to use.

3. Once you have selected the desired setting, you can use it immediately inside the
application.

Through the Shuttle device Helper you can verify that the software is recognizing the
application currently in use: simply move the mouse cursor above the Shuttle device Helper icon
(without clicking on the icon) and a pop window will show you the name of the application
currently in use.

N - HOTOSHOP EXE

Q‘)O 'S, S:30PM

Fig. 4-1

4.2 Using multiple devices

You can simultaneously plug in up to two Shuttle devices of the same model.

For each model, when two devices are plugged in, one device is defined as primary, the other
as secondary. The order in which the devices are plugged in determines their status as the
primary or secondary device. More on this below...

This mechanism is very useful when you have multiple-mode applications for which more than
one setting has been created. For these applications you can target settings, either to be
primary-device specific or secondary-device specific. A primary-device specific setting will be
used only by the primary device. Refer to paragraph 5.4 for guidance on how to target settings.
The software automatically determines the status of the device (primary or secondary) and will
not lose this information after computer reboot.
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5 Programming your Shuttle device

This section will analyze in detail the operations you can perform on settings from the Options
button in the Settings Management section.

Before going through the contents of this section, open the Control Panel (refer to
paragraph 2.2 for guidance on how to accomplish this).

Note: Changes you perform on settings will not take effect until you press Apply or
OK. (OK will automatically close the Control Panel.) You can press Cancel to close the
Control Panel without saving your changes.

5.1 Create New Settings

5.1.1 Create New Settings from Existing Settings
This function allows you to create new settings by copying them from existing settings.

1. Click on the Target Application Menu and select the application setting you would like to
copy. (After so doing, you should now see this setting name in the Target Application
Menu).

2. Click on the Options button in the Settings Management section and select Create new
settings.

Create new settings > Create Empty Settings

Rename settings Copy contents from Global Settings
Change target application Copy contents from Current Settings
Change target device »

Revert to factory settings
Remove settings

Import settings
Export settings
Export settings info

Rebuild the whole settings file

3. Select either the second item Copy contents from Global Settings
or the third Copy contents from Current Settings.
4. A dialog box will prompt you to locate the target application. Select the application you want
the new settings to be associated with and click Open in the right hand of the dialog box.
5. The name of the application will now appear in the Target Application Menu. Refer to
paragraph 5.2 to change the application setting name. All the Shuttle components are set
by default to Do Nothing. Refer to paragraph 3.3 for guidance on how to modify their function.
Repeat step 5 for each Shuttle component you would like to modify.
Once you have completed the desired changes, click the Apply button and then close the
Shuttle device Control Panel. You are ready to use the setting(s) within the selected
application of your choice.

No
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5.1.2 Create Empty Settings

This function allows you to create new settings for any application on your computer. This
application you wish to use a Shuttle device with should meet one of the following criteria:

- allow keyboard shortcuts to various functions within the application,

- support scrolling and/or moving along time lines or frames.

Before analyzing the procedure itself, here are a couple of tips that can be useful when you

want to create new settings from scratch.

For the buttons:

1. create a list of all the keyboard shortcuts available for your application.

2. identify the ones you use most frequently.

3. associate the keyboard shortcuts to the buttons in the way that is most comfortable and
efficient for you.

Jog and Shuttle are very useful for scrolling and/or moving along a time line or time frame.

The Shuttle positions are usually associated with the same Computer response, but the related

frequencies will differ.

In order to create new settings:
1. Click on the Options button in the Settings Management section and select Create new
settings.

Create new settings 4 Create Empty Settings ‘

Rename settings Copy contents from Global Settings
Change target application Copy contents from Current Settings ‘
Change target device »

Revert to factory settings
Remove settings

Import settings
Export settings
Export settings info

Rebuild the whole settings file

N

Click on the first item Create Empty Settings.

3. A dialog box will prompt you to locate the Target Application. Select the application you
want to target and click Open in the right hand of the dialog box. The file you should select
is normally the executable file (.exe) for the application. (In some cases the target is a .mod
file as in the case of Pinnacle Edition.)

4. The name of the application will now appear in the Target Application Menu. Refer to
paragraph 5.2 to change the setting name. All the Shuttle components are set by default to
Do Nothing. Refer to paragraph 3.3 for guidance on how to modify their function.

5. Repeat step 4 for each Shuttle component you would like to modify. If you have finished the
desired changes, click the Apply button.

6. Close the Shuttle device Control Panel and use the setting(s) within the selected application

of your choice.

Note: It is strongly recommended that you set up all of the Shuttle positions. If you do

not want a Shuttle Knob position to perform a function, then set that position to Do Nothing
or Same as Lower Value.
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5.2 Rename Settings

If you want to rename an application setting:

1.

2.

3.

4.
5.

Click on the Target Application Menu and select the application setting you would like to
rename. (You should now see this setting name in the Target Application Menu).

Click on the Options button in the Settings Management section. The setting you selected in
step 1 should be highlighted. Select Rename Settings from the pull-down menu.

Enter a name of your choice (up to 31 characters) in the Target Application field. You MUST
use a different name for each setting.

Press Enter on your keyboard to save the new name.

Click Apply to validate the change.

5.3 Change Target Application

If you want to change the target application (the executable file to which the setting is related):

1.

Click on the Target Application Menu and select the application setting that you would like
to associate to another application. (After so doing, you should now see this setting name
highlighted in the Target Application Menu).

Click on the Options button in the Settings Management section. Select Change target
application from the pull-down menu.

A dialog box will prompt you to locate the target application. Select the application you want
and click Open in the right hand of the dialog box.

Click Apply to validate the change.

5.4 Change Target Device
By default all settings are targeted to all devices.

For multiple-mode applications that have more than one setting, you can tag settings either to
be primary-device specific or secondary-device specific, so that they will be used only by the
corresponding device.

1.

Click on the Target Application Menu and select the application setting you would like to
tag. You should now see this setting name highlighted in the Target Application Menu.

2. Click on the Options button in the Settings Management section. Select Change target

device from the pull-down menu.

Create new settings 4
Rename settings ‘
Change target application ‘

. al |
Revert to Factory settings Primary
Remove settings Secondary

§ Mone (inactive)
Import settings

Export settings
Export settings info

Rebuild the whole settings file
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You can choose between:

f Al (identified by the icon °0): if you have more than one Shuttle device, the setting will
be used by all devices.

f Primary (identified by the icon f’) only the primary device will use this setting.

f Secondary (identified by the icon °) onIy the secondary device will use this setting.

f None (inactive) (identified by the icon f). this option essentially disables the setting.

The icon on the left side of the application in the Target Application Menu will change

according to the choice you performed.

Click Apply to validate the change.

5.5 Revert to Factory Settings

When you modify a factory setting, this setting is tagged as Customized. You can restore the
factory setting through this option:

1.

Click on the Target Application Menu and select the application setting that you would like
to restore. You should now see this setting name highlighted in the Target Application
Menu.

Click on the Options button in the Settings Management section. Select Revert to factory
settings from the pull-down menu.

The setting is reverted to the original factory settings and tagged as Factory Settings as it
was at installation.

Click Apply to validate the change.

Note: This operation also reverts to the original target application (in case you retargeted
the setting to a different executable.)

5.6 Remove Settings

You may want to remove (delete) an application setting from the target application list.

1.

Click on the Target Application Menu and select the application setting you would like to
remove. (After so doing, you should now see this setting name in the Target Application
Menu).

Click on the Options button in the Settings Management section and select Remove
settings.

A dialog box will prompt you: “Are you sure to remove the selected settings?”. Click Yes.
The application setting is now removed from the Target Application Menu.

Click Apply to validate the change. (Once you have clicked Apply, the operation can't be
undone.)

Note: you can import the same setting again later as we maintain a list of settings available
for download on our website. This is sometimes useful as well when Contour releases a new
version of settings for a particular application that we have found a better solution for.
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5.7 Import Settings

Note: This import capability exists ONLY when an established setting is available. An alternate
approach could be to export a setting and, in so doing, give it a different name — the one you
want to use for a future import.

—

Click on the Options button and select Import settings.

Locate the setting you wish to import.

3. Once you have chosen the setting you want to import click OK. This setting will now appear
in the Target Application Menu.

4. Click Apply when completed.

N

5.8 Export Settings

If you want to export an application set, in order to share it with other users, or back it up for
security:

1. Click on the Target Application Menu and select the application setting you would like to
export. (After so doing, you should now see this setting name highlighted in the Target
Application Menu).

Click on the Options button. Select Export settings from the pull-down menu.

A dialog box will prompt you to type a name for the file that will be created and to choose
its destination folder. Once you have done so, click on Save in the lower right hand of the
dialog box. The created file will have the .pref extension and will be located where specified.

w N

5.9 Rebuild the whole settings file

This option will reset the settings collection of all Shuttle devices to the factory provided one.

Note: With this operation all user-made settings and customized settings created
for all Shuttle devices will be lost and this operation can’t be undone.

1. Click on the Options button and select Rebuild the whole settings file from the pull-

down menu.
2. A warning message will ask you to confirm this operation. Click Yes to proceed.
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6 Programming macros with Key Composer™ (ShuttlePRO v2
only)

This section will analyze in detail how to create new macros for your ShuttlePRO v2 in the Key
Composer tab.

A macro is an automated sequence of actions (divided in one or more groups) that can be
stored and then recalled with a single Shuttle component. By action we mean: keystroke
combinations, keystroke sequences (text) or pause events. An event on the Shuttle component
associated to a macro corresponds to the execution of one single group of action(s).

[Macro
»Group 1 | action 1
action 2
I
I

l "] 1 event on the
Shuttle component

Group 2 | action 1 |+
action 2

1 event on the |
Shuttle component | “] 1 event on the

Shuttle component

| Ay

| — 1 event on the

Group n | action 1 “T Shuttle component
action 2

- |
|
I

This definition leads to two different kinds of macros:
- macros composed by one group of actions, identified by the icon 1* 3
- macros composed by two (2) or more groups of actions, also called step-by-step macros,

identified by the icon . Step-by-step macros are very useful to switch views or to toggle
between tools.

Before going through the contents of this section, open the Control Panel (refer to
paragraph 2.2 for guidance on how to accomplish this) and select the Key Composer tab.

To create a new macro:

1. Click on New in the Macro selection window.

2. A macro called ‘Untitled” will be automatically created. Type the name of your new macro
then type Enter.
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3. Click on Add in group or New Group in the Action Sequence window to create a new
action or a new group.

4. A dialog box will prompt you to choose if you want to type a keystroke combination or some
text, or if you want to associate a pause event.

Macro action editor

(® Keystroke combination alt+0

O Type text

O Pause milliseconds

| ok |[ Cancel ]

Select the option you prefer, than click OK in the lower right hand corner of the dialog box.
The newly created action will appear in the Action Sequence window.
5. Repeat steps 1 and 4 for as many macros and actions as you want to add.

Let’s explain how macros work through three examples. We will create:
- one macro composed by one group of multiple actions,
- one macro composed by multiple groups of multiple actions each.

6.1 Macro with one group of multiple actions

Let's create a macro that will apply the following font: Tahoma font, style bold, size 11, in a
program like Microsoft Word or Notepad.

You usually apply this font by using the mouse or by typing a keystroke sequence on your
keyboard. Here are the actions you usually perform to apply these changes:
click on Format on the standard toolbar (or type Alt+0)

go down to Font (or type F)

click on the Font click (or type Alt+F)

select Tahoma from the list (or type Tahoma in the Font field)

click on the Font Style field (or type Alt+Y)

select Bold from the list (or type Bold in the Font Style field)

click on the Size field (or type Alt+S)

select 11 from the list (or type 11 in the Size field)

click OK (or press the Enter key) to confirm our changes.

WoONO AWM
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Let's create a macro based on these actions:

WoONOORWN

Click on New in the Macro selection window.

Type My favorite font then type Enter.

Click on New group in the Action Sequence window.

Choose Keystroke combo from the dialog box and type Alt+0 (to enable the Format tab).
Click on Add in group in the Action Sequence window.

Choose Keystroke combo from the dialog box and type F (this will enable the Font option).
Click on Add in group in the Action Sequence window.

Choose Keystroke combo from the dialog box and type Alt+F (to enable Font field).

Click on Add in group in the Action Sequence window.

. Choose Type text from the dialog box and type Tahoma.

. Click on Add in group in the Action Sequence window.

. Choose Keystroke combo from the dialog box and type Alt+Y (to enable Font Style field).
. Click on Add in group in the Action Sequence window.

. Choose Type text from the dialog box and type Bold.

. Click on Add in group in the Action Sequence window.

. Choose Keystroke combo from the dialog box and type Alt+S (to enable Size field).

. Click on Add in group in the Action Sequence window.

. Choose Type text from the dialog box and type 11.

. Click on Add in group in the Action Sequence window.

. Choose Keystroke combo from the dialog box and select Enter (to close and confirm

changes).

. Type the description of your choice in the description field, for example: This macro applies

the following font: Tahoma, style bold, size 11.

Your newly created macro will be displayed as depicted in Fig. 6-1.

Contour, Shuttle Device Configuration @

ShuttlePRO v2 | Key Composer™ | about
Macro selection
&F My favorite font v
[ omew | [ Rename ] [ Delete ]
General properties Action sequence
1. Keystroke combo: Alt + O
Description 2. Keystroke combo: F
This macro applies the following font: 3. Keystroke combo: alt + F
Tahoma, style bold, size 11.
4., Type text: Tahoma
5. Keystroke combo: alt +
6. Type text: Bold
7. Keystroke combo: Alt + 5
8. Type text: 11
9. Keystroke combo: Enter
[Add in group ] [ New Group ] [ Remove ]
% [ oK ] [ Cancel ] [ Apply ]
Fig. 6-1
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From your ShuttlePRO v2 tab you will now be able to associate the newly created macro to a
Shuttle component, let's say Button 13 (refer to paragraph 3.3 for guidance on how to
accomplish this) as shown in Fig. 6-2.

Pressing Button 13 will play through all the actions shown in the Action sequence window.

Contour Shuttle Device Configuration @

ShuttlePRO v2 | Key Composer™ || About
Settings management Device events control
Target application User action

9 Microsoft Word v %3 Button 13 v

Customized Settings

Computer response

Macro v
— {
( /WK'E \Q/ Macro
( &F My favorite font v
’ P Q
~/ Y

MNew

\‘\’} / Comment
‘ Font
% [ oK ]] Cancel l[ Apply
Fig. 6-2

6.2 Macro with multiple groups of multiple actions

Let's create a macro that allows you to toggle views (Normal, Web Layout, Print Layout,
Outline) in Microsoft Word.

You usually select views by using the mouse or by typing a keystroke sequence on your keyboard,
specifically by clicking on View on the standard toolbar (or typing Alt+V), then going down to
Normal (or typing N), Web Layout (or typing W), Print Layout (or typing P), Outline (or typing O).

Let’s create a step-by-step macro based on these actions:

Click on New in the Macro selection window.

Type Word - views then type Enter.

Click on New group in the Action Sequence window.

Choose Keystroke combo from the dialog box and type Alt+V (to enable the View tab).
Click on Add in group in the Action Sequence window.

Choose Keystroke combo from the dialog box and type N (to select the Normal view).
Click on New group in the Action Sequence window.

Choose Keystroke combo from the dialog box and type Alt+V (to enable the View tab).
Click on Add in group in the Action Sequence window.

10 Choose Keystroke combo from the dialog box and type W (to select the Web Layout view).
11. Click on New group in the Action Sequence window.

12. Choose Keystroke combo from the dialog box and type Alt+V (to enable the View tab).

WoOoNOODWN =
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13. Click on Add in group in the Action Sequence window.

14. Choose Keystroke combo from the dialog box and type P (to select the Print Layout view).

15. Click on New group in the Action Sequence window.

16. Choose Keystroke combo from the dialog box and type Alt+V (to enable the View tab).

17. Click on Add in group in the Action Sequence window.

18. Choose Keystroke combo from the dialog box and type O (to select the Outline view).

19. Type the description of your choice in the description field, for example: This macro allows
to toggle between views in Microsoft Word.

Your newly created macro will be
displayed as depicted in Fig. 6-3.

From your ShuttlePRO v2 tab you will
now be able to associate the newly
created macro to a  Shuttle
component, let's say Button 13 again,
as shown in Fig. 6-4.

Each time you press Button 13, you
cycle between groups of actions, by
execute the next group of the list.
Once the last group has been played,
the next pressure of Button 13 will
reset the execution point to the first
group in the list.
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Contour, Shuttle Device Configuration @

| ShuttlePRO v2 | Key Composer™ | about

Macro selection

| ¥ word views v |

[ New |[ Rename ][ Delete ]

General properties Action sequence ‘

‘ 1. Keystroke combo: alt + v
|2. Keystroke combo: M

3. Keystroke combo: Alt +

Description

This macro allows to toggle between
views in Microsoft Word,
4, Keystroke combo: W

5. Keystroke combo: alt + ¥
6. Keystroke combo: P

7. Keystroke combo: Alt + v
8. Keystroke combo: O

[Add in group] [ MNew Group ] [ Remove ]

% [ oK ] [ Cancel ] [ Apply ]
Fig. 6-3
Contour, Shuttle Device Configuration @
ShuttlePRO v2 | Key Composer™ | About
Settings management Device events control
Target application User action |
®o Microsoft Word v % $ Button 13 v
Customized Settings
g Computer response
Macro v
Macro
Q’ Word views v
MNew
Comment
Switch views
[ oK ] | cancel | [ Apply ]
Fig. 6-4
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7 Updating or Uninstalling your Shuttle device Software

Periodically, Contour provides new software updates on the website for downloading. We
encourage you to stay current with your software to avoid incompatibilities with applications
and setting features. Shuttle Device software is available at: http://www.contourdesign.com.

7.1 Updating from version 1.x
You will have to uninstall version 1.x before installing the new version (2.0 or later).

When uninstalling version 1.x, all settings within the Control Panel will be lost.
Factory settings will be restored by version 2.x.

It is strongly recommended that before uninstalling the software, you export any application
settings that you have created or modified from Factory settings (or write down all parameters
for each setting that you wish to keep and use later on). You will have to import saved application
settings or reprogram all custom application settings into the newly installed version.

To export settings:

1. Open the Control Panel.

2. Click on the Target Application Menu and select the application setting you would like to
export.

3. Click on the Target Application Functions Menu. The setting you selected should be highlighted.
Select Export Settings from the pull-down menu.

4. A dialog box will prompt you to type a name for the file that will be created and to choose
its destination folder. Once you have done so, click on Save in the lower right hand of the
dialog box. The created file will have the .pref extension and will be located where specified.

5. Repeat steps 2,3 and 4 for each setting you would like to export.

6. Close the Control Panel.

To uninstall version 1.x:

1. Click on the Start Menu in the lower left corner of your screen.
2. Select Programs and then Contour from the submenu.

3. In the Contour submenu click on the uninstaller.
4
5

. A dialog box will prompt you to uninstall, click Yes.
A dialog box will now prompt you stating that the software has been removed. Click Close
and exit the uninstall program.

7.2 Updating from version 2.x

Uninstalling the existing version is not necessary when updating a software version later than
2.0. Simply install the update above the existing version.

If the new Applications Settings list contains new Factory settings with respects to the Factory
settings existing in your Applications Settings list, those settings will be added or updated.
Customized and user-made settings will be left untouched.
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7.3 Updating your Application Settings List manually

In order to begin, you must complete the following:

1. Log on to our website and locate the Downloads section.

2. Download the Shuttle device Application Settings only and store the file in a folder of your
choice on your system.

3. Open the Shuttle device Application Settings Folder.

4. Peruse the list and see which Application Setting you are apt to use.

5. Open the Contour Shuttle device Control Panel and import the settings you wish to use.
Refer to paragraph 5.7 for guidance on how to accomplish this.

7.4 Uninstalling Shuttle Device Software
This section describes how to uninstall the Shuttle Device software.

Step 1. Click on the Start Menu in the lower left corner of your screen.

Step 2. only for Windows 98 and 2000 users: Go up to Settings.

Step 3. Select Control Panel.

Step 4. Double-click on Add/Remove Programs.

Step 5. Locate and click on Contour Shuttle.

Step 6. Click on Change/Remove.

Step 7. Inthedialog box select Uninstall Contour Shuttle, then click Next.

Step 8. The dialog box shown in Fig. 7-1 will ask you to confirm the removal process. Click
Next.

Step 9. A dialog box (Fig. 7-2) will now prompt you stating that “Ghost Installer successfully
removed Contour Shuttle and all its components from your computer. Click on the
Finish dialog button to exit the uninstallation process.”

Uninstall Program for, Contour Shuttle

computer.

Uninstall for Contour Shuttle

This program will remove Contour Shuttle and all its components from this

Are you sure you want to completely remove the Contour Shuttle and all its components from your Ghost Installer successfully removed Contour Shuttle and all its components from your computer.
computer?

To confirm the removal process press Next button. Click on the Finish dialog button to exit the uninstallation process.

WARNING! Be careful the uninstaller may also delete Contour Shuttle settings and data
directories. Please backup the data which is stored in subdirectories of Contour Shuttle.

N Uninstall Succeeded

N N

AN/ L\

[ < Back ” Next > ][ Cancel Finish

Fig. 7-1 Fig. 7-2
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